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Abstract - All papers must include an abstract and a set of 

index terms.  The Abstract and Index Terms text must be 

10 point Times New Roman, fully justified and contained 

within one paragraph.  Begin the Abstract with the word 

Abstract - in Times New Roman italic.  The entire 

Abstract should be in bold.  Do not indent.  Use a standard 

dash after the word “Abstract.”  Do not cite references or 

use abbreviations in the abstract.  It should be 

approximately 125 - 175 words. A copy of this abstract will 

be copied and included in the conference program book so 

please follow these guidelines to ensure every presentation 

will have an abstract in the program book.   

 

Index Terms - About four, alphabetical order, key words or 

phrases, separated by commas (e.g., Environment 

Rejuvenation, Remediation, Two-column format). 

PAGE LAYOUT [HEADING] 

These instructions serve as a template for Microsoft Word, 

and give you the basic guidelines for preparing publication-

ready papers. Please carefully follow the instructions 

provided in these guidelines to ensure legibility and 

uniformity.  The guidelines are designed to reduce the amount 

of white space and maximize the amount of text that can be 

placed on one page.    

We suggest you just use this document as your guide 

and simply cut and paste your text over the material in 

this document. Please do not use footnotes, you can use 

end-notes instead, of size 8 points. 

PAPER LENGTH [HEADING] 

Papers should be between 3000-5000 words. 

 

OVERALL FORMAT SPECIFICATIONS [HEADING] 

All papers must use the following layout:  

 

• 8 1/2" x 11" paper size 

• Portrait Orientation 

• Two-column format for the body of the document 

• Top margin: 0.75"  

• Bottom margin: 1.0"  

• Left and right margins: 0.75"  

• Spacing between columns: 0.20"  

• Column width: 3.4"  

• Indents - first paragraph of section - none  

• Indents - all other paragraphs - .25"  

• Header and Footers 0.5 inches 

 

Set all these values using the "FILE" Menu.  Select the 

Page Setup – Margins tab option and click on portrait 

orientation option.  The above margin dimensions can then be 

inserted into the Page Setup Window.  Now select the Paper 

tab and click on the paper size and select the letter paper size.  

Next select the Page Setup – Layout tab and set the Header 

and Footer to 0.5 inches.  To set the column width, click 

anywhere in the document within the two column format, then 

Select the Columns for the Format menu.  Click on the Equal 

Column Width and set the spacing.  Make sure you also apply 

to "This Section.” 

When formatting your document, make consistent use of 

punctuation marks and spelling.  Either American or British 

formatting is acceptable, but it must be consistent, not a mix.  

For example, 

• Putting all commas and periods either inside (American) 

or outside (British) of quotation marks 

• Use of single quotes, e.g. 'service center' (British) rather 

than “service center" (American). 



 

 

• Spellings such as grey and disc (British) vs. gray and disk 

(American). 

PAPER TITLE AND AUTHOR DATA [HEADING] 

The title and author data is in one-column format, while the 

rest of the paper is in two-column format. To accomplish this, 

most word processors have a section break that is installed to 

separate the one and two-column format.  There are two ways 

to setup this format: 1) Use this template as a guide, 2) make 

your own.  If you wish to make your own, it is suggested that 

you open a new document and begin by inserting the title and 

author information in the standard one-column format.  Please 

adhere to the following style guidelines: 

 

• Paper title: This information should be placed at the top 

of the first page in 24 point, Times New Roman in Title 

case, and centered.  This style is defined under the style 

menu of this document as "TITLE.” 

• Insert a 11 point blank line between the Title and the 

Author listing and between the Author listing.   

• Author listing: 11 point, Times New Roman, centered.  

This style is defined under the style menu of this 

document as "Author.”  For Special and Panel Session, 

list all panelists as authors.  Include only the author 

names in the author listing.  Use the full first name for the 

authors.  If an author is submitting more than one paper 

please provide the same name on both papers. Be 

consistent as the name you provide on the paper will be 

what is used to create the author index for the 

proceedings. 

• Author Affiliations: 10 point, Times New Roman, 

centered under the author name.  This style is defined 

under the style menu of this document as "Affiliations.”  

Information for each author such as email, department or 

college, university, city, state and zip can be listed.  If you 

list the email address make sure the Hyperlink is not 

attached.  If the email address turns a color that means 

the hyperlink is active.  Right click on the address and 

select Remove Hyperlink.  There are 3 basic types of 

setups that will be encounter: One author, multiple 

authors from the same institution and multiple authors 

from multiple institutions.  If the paper has one author use 

the affiliation layout as shown at the top of this document 

where all the author information is listed under the paper 

title.  For multiple authors, from the same institution, list 

the common university, then list the email addresses at 

the end in the same order as the authors appear in the 

Author Listing.  For multiple authors from multiple 

institutions list the author names under the title, then list 

the author emails under their names.   Additional 

information for multiple authors can be added to the 

Author Information section at the end of the paper. 

PAPER BODY FORMAT 

I. Column Format Instructions [SUB-HEADINGS] 

The title and author data is in one-column format, while the 

rest of the paper is in two-column format. To accomplish this, 

most word processors have a section break that is installed to 

separate the one and two-column format. For example, in 

Word, under the Insert menu select Breaks – Continuous. 

After you enter the title and author information enter a 

few blank lines and then insert a Continuous section break.  

Now you must define this section to be in two-column format.  

To do this in Word, under the "Format" menu select 

"Columns.” This option will open the Columns window.  It 

has an input box for the number of columns. Enter 2 and then 

set the spacing to 0.2" and select equal column widths.  If you 

have the margin widths set correctly, the width of the column 

should display as 3.40.”  If it does not, go to the "File" menu 

and select “Page Setup - Margins.” This will open the "Page 

Setup" window that will allow you to set the top and bottom 

margins to 1" and the right and left margins to 0.75.”  Every 

word processor will have its own method of accomplishing 

the above setting, however, most follow the same format. 

For "Work in Process" or "Panel Session" submissions, 

if the paper does not fill the entire page and covers more than 

4 inches of the first column, please balance the paper within 

the two-columns.  The easiest way to do this is to insert a 

section break at the end of the document. 

II. Font and Spacing Instructions[SUB-HEADING] 

Use the full justify option for your columns, and use two-

columns in all pages. The two columns must always exhibit 

equal lengths and you should try to fill your last page as much 

as possible. To obtain such results, you are free to adjust the 

figure sizes provided this does not compromise their clarity. 

Use one line of space between text and section headings. Use 

one line of space between text and captions, equations, and 

tables. Use the spelling and grammar checkers.  Do not use 

the “hyphenation” feature in Word. Please use the following 

font and alignment instructions: 

• Body text: 10 point, Times New Roman, full justified, 

single space, no blank lines between the paragraphs. 

Indents - first paragraph of section - none (this style is 

defined under the style menu of this document as "First 

Paragraph"), Indent - all other paragraphs - .25" (this 

style is defined under the style menu of this document as 

"Body Text").  Follow the examples shown in this 

document. 

• Section Headings: 10 point, Times New Roman, bold, 

centered, use SMALL CAPS, leave one blank line above 

and below.  For example, "Page Layout" on page one of 

this document is a Section Heading (this style is defined 

under the style menu of this document as "Section 

Headings").  To convert the text to small caps, click on 

the “Home” tab, and select the pull down arrow in the 

“Font” submenu.  This will open the “Font Window” 

where you can select the Small Cap option. 

• Section Sub-headings: 10 point, Times New Roman, 

italic, left justified, leave one blank line above and below.  

For example, "Font and Spacing Instructions" on this 



 

 

page is a Section Sub Heading (this style is defined under 

the style menu of this document as "Subheading"). 

• Bullets: 10 point, Times New Roman, left justify and 

indent the text 0.25.”  Insert a blank line after the bullet 

list but not before, follow the examples in this document 

(this style is defined under the style menu of this 

document as "Bullets"). 

III. Page Numbering[SUB-HEADINGS] 

The page number on your manuscript is centered at the bottom 

of the footer.  The final page number will be modified by the 

conference before the file is saved into the proceedings 

FIGURES AND TABLES 

All figures and tables must fit either one or two-column width, 

3.4" or 7" wide respectively.  It is suggested that you use one-

column whenever possible.  If your table or figure will not fit 

into one-column, then insert a continuous section break before 

and after the table or figure, as described above and define it 

as one-column.  To make the paper read easier you may want 

to position any table or figure that requires one-column either 

at the bottom of the page or the top of a new page. 

Do not abbreviate “Table”; use Roman numerals to 

number tables. Use the following format guidelines for 

figures and tables: 

• Figure and table headings: 8 point, Times New Roman 

UPPERCASE, centered. Place below the figure and 

above the Table, (this style is defined under the style 

menu of this document as "Figure Heading") 

• Leave one blank line above and below each Table or 

Figure.  

• Figure and table captions: 8 point, Times New Roman, 

SMALL CAPS, centered.  Place below the figure or table 

headings (this style is defined under the style menu of this 

document as "Figure Caption") 

• Table text: 8 point, Times New Roman, (this style is 

defined under the style menu of this document as "Table 

text") 
 

Table I and Figure 1 below illustrates proper Table and 

Figure formatting.  Avoid placing figures and tables before 

their first mention in the text. Please follow the following 

rules for inserting graphics as figures: 

The manuscript’s graphics should have resolutions of 

600 dpi for monochrome, 300 dpi for grayscale, and 300 

dpi for color. 

• Graphics should be inserted into the manuscript file using 

the “Insert – Picture – From File” option in the “Insert” 

tab.  This means you must save every graphics as a 

separate file.  Do not use cut and paste to insert graphics. 

• Do not link to a graphic.  When inserting figures or tables 

be sure you insert the figure and not just a link to the 

figure.  The best way to make sure you are doing this 

correctly is to save your paper, then open the file on a 

different machine and make sure all your figures are 

correct.  If you insert the link instead of the figure or 

table, a box with a big red x will appear in the location 

where the table or figure is supposed to be located. 
 

TABLE I 

POINT SIZES AND TYPE STYLES 

Points  Place of Text Type Styles 

8 

8 

8 

8 

8 

8 

10 

10 

10 

10 

10 

10 

11 

24 

Table number 

Table text 

Figure and Table Headings 

Figure and Table Captions 

Footnote 

Reference list 

Footer 

Abstract 

Index Terms 

Section Titles 

Main Text and Equations 

Subheadings 

Authors’ names 

Title  

ROMAN NUMERALS 

 

UPPERCASE 

SMALL CAPS 

 

 

Bold 

Bold 

 

SMALL CAPS, BOLD 

 

Italic, Left justified 

 

Title Case 

 

 

 
 

FIGURE 1 

LOGO OF THE  UNIVERSITY JAMIA MILLIA ISLAMIA 

 

ACKNOWLEDGMENT 

The preferred spelling of the word "acknowledgment" in 

American English is without an "e" after the "g." Use the 

singular heading even if you have many acknowledgments.  

Please put the sponsor acknowledgments in this section; do 

not use a footnote on the first pages.  

IN TEXT REFERENCES 

All material from any research resource must be accompanied 

by a bracketed in-text reference.  This reference must 

correspond to its end-text full bibliographic information in the 

References section.  Failure to properly reference all resource 

material used in a paper leaves the paper’s author open to 

charges of plagiarism. Follow these specifications for in-text 

references: 

 

In-text Citation to References: When citing a reference 

from your reference list, please use the following 

conventions. Put in parentheses the author(s) last names, the 



 

 

year, and optionally the page number(s) separated by 

commas. 

For one author, use the author's last name and year separated 

by a comma. For example: (Walters, 1994) or (Austin, 1996). 

For two to five authors, use their last names separated by 

commas and with an ampersand "&" before the very last name 

in the list, then the year separated by a comma. For example: 

(Li & Crane, 1993) (Charniak, Riesbeck, McDermott & 

Meehan, 1994). 

For more than five authors, use the first author's last name and 

"et al." For example: (Walters, et al., 1992). 

For the date, use the year. If there are two references by the 

same author(s) for the same year, use letters after the year: 

(Walters, 1993b). 

If there are specific page numbers for a citation, add them 

after the year (Walters, 1994, pp. 31-49). 

If you include the author's name(s) in the text of a sentence in 

the paper, you may omit their names from the parentheses as 

follows: "Austin (1996) includes valuable references to ...." or 

"The examples given by Li and Crane (1993) on web 

addresses ...". 

REFERENCES 

All of the examples given above may be summarized by citing 

a few references in the form we would like you to use. Here 

are some examples that would be cited in the text as (Crosley, 

1988), (Essinger, 1991, May 28, pp. 97-99), (Armstrong & 

Keevil, 1991, p. 103), and so forth. 

Printed Book 
Crosley, L.M. (1988). The architects' guide to computer-aided-design. 

Toronto: John Wiley & Sons. 

Magazine Article 
Essinger, J. (1991, May 28). Just another tool of your trade. Accountancy 108, 

pp. 91-125. 

Journal Article 
Armstrong, P. and Keevil, S. (1991). Magnetic resonance imaging-2: Clinical 

uses. British Medical Journal 303(2), 105-109. 

Interview 
Computer, Christopher C. (1996, January 10) Professor, Computer Science 

Department, University of California - Davis, 3:00 pm, Davis, California. 

World Wide Web Address 
Austin, A. (1996) Annotated List of World Wide Web Technical Writing and 

Computer-Aided Composition Resources [Online]. Available: 

http://wwwcsif.cs.ucdavis.edu/~austina/cai.html. 

Burke, J. (1992, January/February). Children's research and methods: What 

media researchers are doing, Journal of Advertising Research, 32, RC2-RC3. 

[CDROM]. Available: UMI File: Business Periodicals Ondisk Item: 92-

11501. 

FTP 
Blood, T. (1995, November 30). Re: Brain implants: the Chinese made it! 

[Online] In Newsgroup: bionet.neuroscience, Available FTP: 

ftp.bio.indiana.edu, Directory: /usenet/bionet/neuroscience, File: 

9512.newsm, Date: Thu, 30 Nov 1995 20:39:35. 

Watson, L, and Dallwitz, M.J. (1990, December). Grass genera of the world-

interactive identification and information retrieval. Flora Online: An 

Electronic Publication of TAXACOM (22). [Online]. Available FTP: 

huh.harvard.edu, Directory: pub/newsletters/flora.online/issue22, 

File:022gra11.txt. 
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AUTHOR INFORMATION 

Use this section to list author information.  For example: 

 

Niharika Rao, Professor, Department of Architecture, 

Faculty of Architecture and Ekistics, Jamia Millia Islamia,

   


